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1

 Inleiding

U hebt de keuze gemaakt te gaan werken met AutoCAD of AutoCAD LT. Auto-
CAD is een van de meest gebruikte technische tekenprogramma’s. Het is een 
uitgebreid en soms complex programma, maar als u de basis eenmaal onder 
de knie hebt, zult u ervaren dat u vrij snel aan tekenen toekomt. Niet voor niets 
heeft AutoCAD miljoenen gebruikers wereldwijd. 

Een groot deel van de complexiteit van AutoCAD is toe te schrijven aan de his-
torie van het programma. In 1982 zag de eerste versie van AutoCAD het licht. 
Dit was in een DOS-periode waarin Windows nog ontwikkeld moest worden. 
Pas sinds versie 13 in 1994 is AutoCAD geschikt om onder Windows te werken. 
AutoCAD is ook te verkrijgen voor de Mac. Hoewel de basishandelingen en 
werkwijze zeer sterk op elkaar lijken, beschrijft dit boek specifiek de Windows-
variant van AutoCAD.

Verschillen tussen AutoCAD en AutoCAD LT
AutoCAD is de volledige uitgebreide versie van het programma. Dit bevat naast 
alle teken- en bewerkingsfuncties onder meer ook functies voor:

•	 3D-tekenen;
•	 geavanceerde	beheerderfuncties;
•	 mogelijkheden	binnen	het	programma	apps	of	plug-ins	installeren.

AutoCAD LT bevat deze functies niet. De manier van werken van beide pro-
gramma’s is echter identiek en 2D-tekeningen van het ene programma kunnen 
worden geopend en bewerkt in het andere. 3D-tekeningen van AutoCAD kun-
nen wel worden geopend in AutoCAD LT, maar kunnen slechts beperkt worden 
bewerkt. 

Alle uitleg en oefeningen in dit boek zijn gebaseerd op een standaardinstalla-
tie van AutoCAD. Daar waar er verschillen zijn met AutoCAD LT in gebruik of 
werkwijze zal dit duidelijk worden aangegeven.

Aanwijzingen voor het gebruik van dit boek
Dit boek is geschreven om u te helpen op uw eerste ontdekkingstocht door 
Auto CAD. Met nadruk wijzen we u erop dat dit boek een basiscursus is. Dat 
houdt in dat niet alle commando’s en ook niet altijd alle opties van een com-
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mando worden behandeld. Dit is een bewuste keuze waarmee we willen voor-
komen dat u het spoor bijster raakt en mogelijk daarbij ook uw enthousiasme! 

Op de websites van Academic Service (www.academicservice.nl) en de auteur 
(www.caddesign.nl) staan alle oefeningen die in dit boek worden gebruikt. U 
kunt deze oefeningen als zip-bestand downloaden. In dit bestand vindt u deze 
oefeningen in tweevoud terug: eenmaal als uitgangspunt voor de oefening en 
eenmaal als voltooide oefening. Kopieer deze oefeningen naar de harde schijf 
van uw computer, zodat u ze eenvoudig kunt openen en bewerken.

Afspraken in dit boek
In AutoCAD kunt u op verschillende manieren een commando starten. De 
meest voorkomende mogelijkheden zijn:

•	 Klik	op	de	knop	van	een	commando	in	de	ribbon	of	werkbalken.
•	 Typ	het	commando	volledig	in.
•	 Gebruik	een	sneltoets	of	toetsencombinatie.

Deze manieren zullen in het boek in de vorm van een tabel worden weerge-
geven: 

Line

Ribbon: 
Menu: 
Intypen:
Sneltoets:

Home > Draw 
Draw > Line
Line (Enter)
L (Enter)

Het is aan u welke methode u gebruikt. Kies de voor u prettigste methode!

Toetsen die u indrukt, worden in een vet lettertype weergegeven, bijvoorbeeld, 
druk op de Enter-toets. Teksten en opdrachten die u moet invoeren, worden 
eveneens vet weergegeven. 

Let op dat alles wat u intypt bevestigd dient te worden met Enter!

De namen van menu’s, commando’s, dialoogvensters, werkbalken en knop-
pen worden in dit lettertype weergegeven. Bijvoorbeeld: kies in het menu File 
het commando Open. Dit lettertype wordt ook gebruikt voor tekst die op het 
scherm verschijnt.

De diverse hoofdstukken bevatten opmerkingen, tips en waarschuwingen. 
Deze zijn achtereenvolgens aangeduid met de tekens: 
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Tot besluit
Net als met autorijden leert u pas echt goed tekenen met AutoCAD door het 
veel te doen. Hoe vaker u een commando gebruikt, hoe eerder u toepassings-
mogelijkheden leert herkennen. Bekijk een tekening die u moet maken niet 
alleen op techniek, maar probeer direct verbanden te herkennen waardoor u 
steeds sneller in staat zult zijn een tekening op te zetten. 

We houden ons aanbevolen voor opmerkingen, uitbreidingen en suggesties 
die kunnen leiden tot verbetering van de inhoud bij volgende drukken. Uw 
reac ties kunt u e-mailen naar de auteur op harold@caddesign.nl.

Ik wil het redactieteam bedanken voor alle t-tjes, d-tjes, punten en komma’s 
en het meedenken, en alle overige medewerkers van Academic Service voor 
de prettige samenwerking! Daarnaast dank aan alle cursisten en lezers die hun 
kritische opmerkingen aan ons hebben doorgegeven.

Wilt u ook thuis kunnen oefenen? Op de website van Autodesk kunt u gratis de 
(30-dagen) trialversie van AutoCAD of AutoCAD LT downloaden. Ga hiervoor 
naar www.autodesk.nl of www.autodesk.com.

Meer informatie over de auteur en eventuele AutoCAD-trainingen vindt u op: 
www.caddesign.nl

Wij wensen u veel succes en vooral plezier bij het tekenen!

Sprang-Capelle, juni 2013
Harold Weistra

Harold
Highlight

Harold
Highlight
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11
1 Starten met AutoCAD

In dit hoofdstuk maken we u wegwijs in de schermindeling van AutoCAD. 

Eveneens leert u de basishandelingen die nodig zijn om AutoCAD te bedienen.

1.1 In dit hoofdstuk

− AutoCAD starten en afsluiten.
− De verschillende delen van de gebruikersinterface benoemen en bedienen.
− Werken met muis en toetsenbord.
− Tekeningen openen, opslaan en sluiten.
− Commando’s starten en beëindigen.
− Helpfuncties binnen AutoCAD.

1.2 AutoCAD starten

U kunt AutoCAD onder andere op de volgende manieren starten:

•	 Via	het	menu	Start.
•	 Via	een	snelkoppeling	op	het	bureaublad.
•	 Door	een	tekening	vanuit	Windows	Verkenner	te	openen.

1.2.1 AutoCAD starten via het menu Start

Via het menu Start van Windows zoekt u in de lijst Alle programma’s naar 
de verzamelmap Autodesk. In deze map staan snelkoppelingen naar alle 
AutoCAD-versies die op uw systeem zijn geïnstalleerd. Ook vindt u hier enkele 
hulpprogramma’s. Kies de submap AutoCAD (LT) 2014 en vervolgens het 
programma AutoCAD (LT) 2014.
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1.2.2 AutoCAD starten met een snelkoppeling

Tijdens de installatie is er een snelkoppeling op het bureaublad geplaatst. U 
start AutoCAD door hierop te dubbelklikken. 

1.2.3 AutoCAD starten via Windows Verkenner

Zoek in Windows Verkenner de tekening die u wilt openen. Dubbelklik hierop 
of klik met de rechtermuisknop en kies Open.

Oefening 1.1 De schermindeling
1 Start AutoCAD met behulp van de snelkoppeling op het bureaublad.
2 Als AutoCAD gestart is, ziet u het Welcome-scherm (zie figuur 1.1). 

Figuur 1.1

Dit Welcome-scherm is in drie delen opgesplitst. In het Work-gedeelte kunt 
u snel een nieuwe tekening beginnen of een bestaande tekening openen. Ook 
verschijnt er een lijst van meest recent gebruikte bestanden. In het Learn- 
gedeelte vindt u de belangrijkste nieuwe functies in AutoCAD 2014. Mocht u al 
bekend zijn met AutoCAD, dan is dit een goede manier om snel bijgespijkerd 
te worden. In het Extend-gedeelte kunt u contact maken met AutoCAD 360, 
uw Autodesk account’ in the cloud’, of de social media-pagina’s van Autodesk 
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bezoeken. U kunt ook apps downloaden bij de Autodesk Exchange Apps (niet 
beschikbaar in AutoCAD LT).

1.3 De gebruikersinterface van AutoCAD 

De gebruikersinterface van AutoCAD 2014 heeft dezelfde uitstraling gekregen 
die u misschien herkent van Microsoft Office. De belangrijkste commando’s 
zijn samengevat in de ribbon boven in het scherm.

Figuur 1.2

Om duidelijkere schermafbeeldingen te tonen wordt in dit boek zo veel moge-
lijk gebruikgemaakt van een egaal witte achtergrond. 
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Figuur 1.3

Deze gebruikersinterface is opgedeeld in een aantal hoofdonderdelen:

1.3.1 Titelbalk (title bar)

Helemaal bovenaan in het venster vindt u de titelbalk. Hierin staan in het mid-
den het versienummer van AutoCAD en de naam van de tekening waaraan u 
werkt.

De titelbalk biedt verder plaats aan:

AutoCAD-menu
Links in de titelbalk vindt u het AutoCAD-menu, de grote rode A (zie figuur 
1.4). Dit menu biedt snel toegang tot de meest voorkomende commando’s om 
bestanden te openen, op te slaan of af te drukken. 
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Figuur 1.4

Quick Access-werkbalk
Naast het menu vindt u de Quick Access-werkbalk. Hierin staan de meest 
voorkomende algemene commando’s zoals: Nieuw, Openen, Opslaan, Afdruk-
ken en Ongedaan maken. 

Workspace
Als u al wat langer met AutoCAD werkt, krijgt u misschien de behoefte de ge-
bruikersinterface naar uw smaak en wensen aan te passen. Het is mogelijk zelf 
onderdelen aan de interface toe te voegen of bestaande onderdelen te wijzi-
gen. Deze gewijzigde instellingen kunt u opslaan als een workspace.

Met behulp van workspaces is het mogelijk te kiezen tussen verschillende ge-
bruikersinterfaces die passen bij verschillende werkzaamheden. Zo zijn in 
Auto CAD 2014 de volgende standaard-workspaces beschikbaar:

•	 Drafting	&	Annotation; 
•	 3D	Basics	(niet	in	AutoCAD	LT);
•	 3D	Modeling	(niet	in	AutoCAD	LT);
•	 AutoCAD	Classic.

De huidige schermindeling met de ribbon is opgeslagen in de Drafting & An-
notation workspace. De 3D-workspaces wijzigen de ribbon zodanig dat deze 
de benodigde 3D-tabbladen en panelen bevat.
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Veel van de commando’s die u vanuit de ribbon kunt starten, vindt u ook terug 
in de menubalk en werkbalken die rondom het tekenveld kunnen worden ge-
plaatst. Veel mensen zullen in figuur 1.5 AutoCAD herkennen zoals het tot ver-
sie 2009 bekend was. Dit is de workspace AutoCAD Classic.

Figuur 1.5

In deze basiscursus wordt gebruikgemaakt van de standaard-workspace Draf-
ting & Annotation. 

Zoekmenu
Rechts in de titelbalk vindt u het Search menu. Het Search menu is geopti-
maliseerd om hulp te zoeken in de helpbestanden of op internet. De resulta-
ten worden getoond in de Autodesk Exchange browser die u ook ziet wanneer 
Auto CAD opstart.

1.3.2 Ribbon

De ribbon vervangt de vroegere werkbalken en menu’s. De belangrijkste Auto-
CAD-commando’s zijn gerangschikt in meerdere tabbladen en panelen. Ieder 
paneel bevat de meest voor de hand liggende functies waarbij sommige pane-
len kunnen worden uitgeklapt om toegang te verkrijgen tot extra functies. De 
hier gebruikte schermafbeeldingen zijn van AutoCAD. Daarin zijn meer tab-
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bladen en panelen te zien dan in de ribbon van AutoCAD LT. De werking is ech-
ter gelijk.

Door op het kleine pijltje in de ribbon te klikken kunt u kiezen uit verschillende 
weergavemogelijkheden. Dit alles om ruimte in het tekenscherm te besparen.

Klikt u met de rechtermuisknop in de ribbon dan kunt u kiezen welke tabbla-
den en panelen getoond dienen te worden (zie figuur 1.6). 

Figuur 1.6

U kunt er ook voor kiezen de ribbon zwevend als een palette op het scherm te 
plaatsen (undock) zoals te zien in figuur 1.7. 

Figuur 1.7
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Eventueel kunt u de ribbon parkeren (anchor left/right) als een dashboard. 
Een dashboard kan met de functie Auto-hide automatisch open- of dichtklap-
pen als u er met de muis bovenop staat of ervan af beweegt. Deze opties vindt 
u door met de rechtermuisknop te klikken in de balk naast de ribbon. Sleep de 
ribbon terug naar de bovenkant van het scherm om deze weer op de originele 
positie terug te zetten.

Het is opnieuw mogelijk het scherm geheel naar eigen inzicht en behoefte in te 
delen. U moet ermee werken en ernaar kijken dus maak het zo comfortabel en 
vertrouwd mogelijk. Ook deze wijzigingen kunt u weer opnemen in een work-
space.

Ribbon bedienen
Wanneer u met de muis over de knoppen in de ribbon beweegt, verandert 
de kleur zodat u duidelijk kunt zien welke knop u op het punt staat te kiezen. 
Houdt u de muis stil boven een knop, dan worden de naam en een korte om-
schrijving van het commando getoond in een tooltip (zie figuur 1.8).

Figuur 1.8

Houdt u de muis iets langer boven de knop, dan verandert de tooltip in een Ex-
tended Tooltip (zie figuur 1.9). Hierin vindt u een uitgebreidere uitleg van het 
commando plus vaak een voorbeeld van de tijdens het commando te volgen 
stappen.

Enkele knoppen hebben een klein driehoekje naast of onder de afbeelding (zie 
figuur 1.10). Zodra u op dit driehoekje klikt, verschijnt er een zogenoemde fly-
out waaruit u variaties van het geselecteerde commando of soortgelijke com-
mando’s kunt kiezen. Op deze manier zijn snel meer commando’s te tonen zon-
der extra schermruimte in beslag te nemen. 

Verschillende panelen zijn ook nog eens uit te klappen door op het driehoekje 
naast de paneelnaam te klikken (zie figuur 1.11). Hierin vindt u de minder vaak 
gebruikte commando’s.
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Figuur 1.9

Figuur 1.10

Wilt u niet dat een uitgeklapt paneel weer dichtklapt nadat u een commando 
hebt gekozen, klik dan op de punaise links naast de paneelnaam. Hiermee prikt 
u het paneel vast op het scherm.

Figuur 1.11
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Tot slot vindt u in verschillende panelen een schuin pijltje rechtsonder in de 
hoek. Klikt u op dit pijltje dan opent een dialoogvenster waarin u verschillende 
instellingen kunt doen of stijlen kunt aanmaken.

De ribbon is een intelligent ding. Bij verschillende commando’s zijn zo veel op-
ties en instellingen mogelijk dat de ribbon automatisch omschakelt naar een 
bijbehorend tabblad dat normaal gesproken niet wordt getoond. Meer uitleg 
hierover volgt bij deze commando’s.

1.3.3 Tekenveld (Drawing Area)

Het overgrote deel van het venster wordt gebruikt voor het tekenveld. U mag dit 
veld beschouwen als een oneindig groot vel transparant papier waarop u uw 
tekening maakt. We noemen dit veld het Model. 

Bovenaan in het tekenveld ziet u een tabblad voor iedere geopende tekening. 
Hiermee kunt u snel wisselen tussen geopende tekeningen, of nieuwe tekenin-
gen beginnen.

Op het moment dat u gaat afdrukken kunt u gebruikmaken van Layouts. U 
vindt dit terug in de tabbladen onder het tekenveld. Meer hierover in hoofdstuk 
14 en 15.

1.3.4 Commandoregel (Command Line) 

In het onderste deel van het venster vindt u de commandoregel. Zodra u een 
opdracht geeft, vraagt AutoCAD u details om deze opdracht uit te voeren. U 
bent dus voortdurend interactief met het programma bezig. Dit hele proces is 
te volgen via de commandoregel. 

Figuur 1.12

De onderste regel van de commandoregel is het actieve gedeelte. Hier typt u 
commando’s, opties of gegevens in. Zodra u begint te typen vult auto-complete 
de mogelijkheden voor u aan.

De bovenste regels geven de commandogeschiedenis of de instellingen van de 
geactiveerde commando’s aan. De commandoregel kan vrijstaand boven het 
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tekenscherm zweven of worden verankerd bovenop de statusbalk. In figuur 
1.12 ziet u beide mogelijkheden. U kunt dit eenvoudig bereiken door op de 
grips te klikken en te slepen (zie pijlen).

1.3.5 Dynamic Input

AutoCAD heeft sinds versie 2006 de functie Dynamic Input. Deze functie laat 
de vraagstelling uit de commandoregels of de opties uit het snelmenu (rechter-
muisknop) naast de kruisdraad zien. We noemen dit de Dynamic Prompt (zie 
figuur 1.13). Het grootste voordeel van deze functie is dat tijdens het tekenen 
ook afmetingen direct worden weergegeven. Het werken met AutoCAD is hier-
door veel intuïtiever geworden doordat u zich concentreert op het tekenveld 
zonder telkens naar de commandoregel te hoeven kijken. Deze optie is helaas 
niet in het gehele programma doorgevoerd, dus op sommige momenten is de 
commandoregel nog onmisbaar. Bent u eenmaal gewend aan Dynamic Input, 
dan hoeft u de commandoregel nagenoeg niet meer te gebruiken en kunt u 
deze verbergen.

Bij Dynamic Input voert u maten in in de daarvoor bestemde velden. Opties 
binnen commando’s kunt u kiezen door op ↓ op uw toetsenbord te drukken.

Figuur 1.13

In deze basiscursus zal zo veel mogelijk gebruikgemaakt worden van de nieuw-
ste mogelijkheden van AutoCAD, dus ook van Dynamic Input. Daar waar 
nodig zal expliciet naar de commandoregel worden verwezen. Om de leesbaar-
heid te vergroten, zien de afbeeldingen van Dynamic Input in dit boek er iets 
anders uit dan bij u op het scherm.

1.3.6 Statusbalk (Status Bar) 

De statusbalk bevat onder andere een groot aantal hulpmiddelen die het teke-
nen vereenvoudigen. Daarnaast kunt u coördinaten uitlezen en verschillende 
instellingen wijzigen (zie figuur 1.14). 
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Figuur 1.14

Deze hulpmiddelen kunt u te allen tijde naar wens in- of uitschakelen. Dit doet 
u door met de linkermuisknop op de knoppen te klikken. Een grijze knop staat 
uit, een blauwe staat aan. De namen van de hulpmiddelen worden getoond in 
een tooltip die verschijnt als u uw muis stilhoudt boven een knop. 

Naam hulpmiddel Functie

Infer Constraints* Automatisch constraints toevoegen.

Snap Mode Volgt het ingestelde lijnraster (zie Grid).

Grid Display Toont lijnraster in het tekenveld.

Ortho Mode Beperkt de vrijheidsgraden tot hoeken van 90 graden.

Polar Tracking Beperkt de vrijheidsgraden tot de gekozen hoeken.

Object Snap Activeert vangfuncties bij puntselectie.

3D Object Snap* Activeert vangfuncties bij 3D-puntselectie.

Object Snap Tracking Geeft virtuele hulplijnen weer.

Allow Dynamic USC* Automatische tekenvlakkeuze bij 3D-tekenen.

Dynamic Input Toont input naast kruisdraad.

Show/Hide Lineweight Toont lijndiktes op het tekenveld.

Show/Hide Trans-
parency

Activeert transparantie van lagen of arceringen.

Quick Properties Toont Quick Properties-paneel op het scherm.

Selection Cycling Hulpmiddel bij selecteren van overlappende objec-
ten.

Annotation Monitor Controleert de koppeling van associatieve objecten

Tabel 1.1: Hulpmiddelen in de statusbalk 

Hulpmiddelen gemarkeerd met * zijn niet beschikbaar in AutoCAD LT en wor-
den niet behandeld in deze cursus. 

1.4 Commando’s geven, afbreken en herhalen

Soms ontstaat er wat verwarring door de vele manieren waarop het moge-
lijk is een commando te geven. Sommige commando’s kunnen op wel vier of 
vijf manieren worden geactiveerd. Er is daarbij geen goede of slechte manier.  
U kiest de manier die u het beste past. Hiervoor zullen wij bij ieder commando 
aangeven welke mogelijkheden u hebt.
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De meest voorkomende mogelijkheden zijn:

•	 Klik	op	de	knop	van	een	commando	in	de	ribbon	of	de	werkbalken.
•	 Selecteer	het	commando	uit	het	betreffende	menu	(AutoCAD	Classic	Work-

space)
•	 Typ	het	 commando	volledig	 in	op	de	commandoregel	of	 in	de	dynamic	

prompt naast de muis.
•	 Gebruik	een	sneltoets	of	toetsencombinatie.

Als voorbeeld het commando Open waarmee u tekeningen opent. De volgen-
de tabel toont de verschillende manieren waarop u het commando kunt star-
ten. Kies zelf de prettigste manier van werken.

Open

Ribbon:
Menu: 
Commandoregel:
Sneltoets:

Quick Access-werkbalk
File > Open…
Open
Ctrl+O

Een volgend punt voor verwarring is het beëindigen van commando’s. Sommi-
ge moeten worden beëindigd door op Enter te drukken, terwijl andere na het 
uitvoeren van een taak zichzelf beëindigen. Het verschil zit hem hierin: 

•	 Als	een	handeling	slechts	eenmaal	uitgevoerd	kan	worden,	beëindigt	het	
commando zichzelf en hoeft u niet meer op Enter te drukken.

•	 Als	u	een	handeling	binnen	een	commando	meerdere	malen	kunt	uitvoe-
ren, dient u het commando zelf met Enter te beëindigen.

Een goed voorbeeld hiervan zijn de commando’s Move (verplaatsen) en Copy 
(kopiëren). Verplaatst u een object, dan wordt het commando beëindigd nadat 
u het object hebt verplaatst. U kunt dus maar één keer verplaatsen. Kopieert u 
een object, dan kunt u meer dan één kopie maken. Om aan te geven dat u klaar 
bent met kopiëren, beëindigt u het commando door op Enter te drukken nadat 
u de laatste kopie hebt geplaatst.

Blijf het verloop van het commando altijd volgen in de Dynamic Prompt of op 
de commandoregel. Hieruit zal altijd blijken of het commando nog actief is 
of niet. Zodra de Dynamic Prompt verdwijnt en in de commandoregel weer 
Command: staat, wacht AutoCAD op een nieuwe opdracht en is het actieve 
commando beëindigd.

In plaats van de Enter-toets mag u ook de rechtermuisknop of spatiebalk  
gebruiken om een commando te beëindigen. 

Soms start u een commando en merkt u dat u het verkeerde commando hebt 
gekozen of dat u eerst nog iets anders wilt doen. Druk maximaal driemaal op de 
Esc-toets op het toetsenbord om alles te annuleren.

➨
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Wilt u het laatst gegeven commando herhalen, druk dan op de Enter-toets of de 
spatiebalk en het laatste commando wordt direct weer geactiveerd.

1.4.1 Opties tijdens commando’s

Bij veel commando’s kunt u tijdens het uitvoeren van het commando voor extra 
opties kiezen. Vaak zijn dit sub-commando’s, binnen het gekozen commando, 
die u kunt uitvoeren zonder het gekozen commando te beëindigen.

De opties zijn meestal op drie manieren te kiezen. Zie figuur 1.15 voor de opties 
tijdens het commando Line (deze zijn in 1 afbeelding gemonteerd om u de ver-
schillen te laten zien).

1 Lees de commandoregel. Hierop staan de opties tussen haken en met een 
achtergrondkleur aangegeven [Optie]. Meestal staat de eerste letter van 
die optie als hoofdletter aangegeven en heeft deze een kleurtje. Typ deze 
letter(s) in en bevestig de invoer met Enter, of klik met de muis op het gear-
ceerde gedeelte, om de optie te kiezen.

2 Klik op de rechtermuisknop. De opties worden in een schermmenu ge-
toond waar u deze kunt selecteren om de optie te kiezen. Behalve de actuele 
opties toont dit menu ook nog een aantal algemene opties of hulpmidde-
len.

Figuur 1.15

3 Als Dynamic Input staat ingeschakeld, kunt u op het pijltje naar beneden 
van uw toetsenbord drukken. Onder de Dynamic Prompt worden dan de 
beschikbare opties getoond. Deze kiest u door de gewenste optie met de 
muis aan te klikken.
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1.4.2 Muisknoppen en muiswiel

Het tekenen met AutoCAD gebeurt voor het grootste deel met de muis. In deze 
basiscursus wordt uitgegaan van het werken met een muis met een muiswiel 
en twee knoppen. Hebt u geen muis met een muiswiel, schaf deze dan zo snel 
mogelijk aan. Het wieltje levert u veel gemak en tijdwinst op.

Waarschijnlijk is het u al opgevallen dat de muisaanwijzer in het venster er an-
ders uitziet dan u gewend bent van de meeste Windows-programma’s. In Auto-
CAD wordt de muisaanwijzer gevormd door een horizontale en verticale lijn 
met in het midden een klein blokje. We noemen deze aanwijzer de kruisdraad 
(cross-hair). Net als het symbool linksonder in de hoek van het tekenveld, het 
UCS-icon, refereert de kruisdraad aan de assen waarmee AutoCAD punten in 
de tekening vastlegt. Dit wordt uitvoerig behandeld in hoofdstuk 6.

De linkermuisknop dient voor het selecteren van menu’s en knoppen in de 
werkbalken, en voor het aanwijzen van punten in het venster. Deze knop wordt 
ook gebruikt om bestaande elementen te selecteren om deze te kunnen bewer-
ken. Zodra u met de kruisdraad het tekenveld verlaat, verandert deze in een 
pijltje.

De rechtermuisknop werkt net als de spatiebalk als een alternatief voor de  
Enter-toets. Er is nu echter wel een verschil. Standaard staat de rechtermuis-
knop intelligent ingesteld. Een klik op de rechtermuisknop zal afhankelijk van 
waar en wanneer u klikt een andere functie hebben. Figuur 1.16 geeft daarvan 
een aantal voorbeelden.

•	 Als	er	geen	commando	actief	is	en	u	klikt	met	de	rechtermuisknop	in	het	
tekenveld, zal een snelmenu worden getoond. Boven in dit snelmenu staat 
altijd Repeat… (+ laatste commando). Daaronder staan enkele opties die u 
op dat moment hebt.

Figuur 1.16
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•	 Veel	commando’s	hebben	extra	opties.	Klikt	u	met	de	rechtermuisknop	tij-
dens een dergelijk commando, dan zal het snelmenu deze opties tonen.

•	 Als	u	voor	een	commando	een	selectie	hebt	gemaakt,	dient	u	AutoCAD	aan	
te geven wanneer u klaar bent met selecteren. Klikt u na het maken van de 
selectie met de rechtermuisknop, dan zal AutoCAD verdergaan met de vol-
gende stap van het commando. U bevestigt dus de selectie.

•	 Hebt	u	een	selectie	gemaakt	zonder	eerst	een	commando	te	activeren	en	
klikt u vervolgens met de rechtermuisknop, dan toont het snelmenu een 
aantal bewerkingen die u direct op de selectie kunt toepassen.

U merkt het, er zijn een groot aantal mogelijkheden. Neem bij de eerste oefenin-
gen ruim de tijd om de verschillende menu’s te bestuderen. Door goed gebruik 
te maken van deze menu’s kunt u zich veel extra handelingen besparen.

Het muiswiel gebruikt u om snel in de tekening te zoomen en te pannen. Door 
te zoomen kunt u details uitvergroten of juist de hele tekening in het venster 
tonen. Door te pannen verschuift u de hele tekening onder uw venster door. U 
maakt dan andere delen van de tekening zichtbaar zonder te hoeven zoomen. 
Deze functies worden in hoofdstuk 3 uitgebreid besproken.

1.4.3 Commando’s ongedaan maken

Undo: het voorgaande commando ongedaan maken
Als een handeling al is uitgevoerd, kunt u het commando Undo gebruiken om 
deze handeling weer ongedaan te maken. Dat kan van alles zijn, bijvoorbeeld 
een lijn tekenen, een lijn verplaatsen of een zoomactie uitvoeren.

De functie Undo kan bij een aantal commando’s ook tijdens het commando 
gebruikt worden. Kijk in de opties binnen het commando of type de letter U 
gevolgd door Enter.

Undo

Ribbon: 
Menu: 
Commandoregel: 
Sneltoets:

Quick Access-werkbalk
Edit > Undo 
Undo 
U of Ctrl+Z

Redo: Undo-commando’s weer ongedaan maken
Met het commando Redo kunt u handelingen weer terughalen die daarvoor 
met Undo-acties ongedaan gemaakt zijn. De ongedaan gemaakte handelingen 
worden dan weer hersteld. Ook de knop van dit commando staat in de Quick 
Access-werkbalk. 
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Redo

Ribbon: 
Menu: 
Commandoregel:
Sneltoets:

Quick Access-werkbalk
Edit > Redo 
Redo
Ctrl+Y

Het commando Oops
De laatste Erase-actie maakt u ongedaan met het commando Oops. Wat u het 
laatst hebt verwijderd uit de tekening, wordt dan weer teruggeplaatst. Het doet 
er niet toe of u na deze Erase-opdracht andere commando’s hebt gebruikt of 
uitgevoerd. Het commando Oops moet u intypen, er is geen knop of menu-
keuze voor.

1.5 Helpfuncties binnen AutoCAD

Raakt u toch nog de weg kwijt binnen AutoCAD? Geen paniek! De helpfuncties 
van AutoCAD zijn zeer uitgebreid. Kreeg u vroeger nog drie dikke boeken bij de 
software, tegenwoordig zijn die helemaal verwerkt in de helpfuncties. U kunt 
de boeken overigens nog wel aanvragen bij Autodesk.

De eenvoudigste manier om hulp bij een commando te krijgen is door gebruik 
te maken van functietoets F1.

Oefening 1.2 Helpfuncties voor het commando Line
1 Start het commando Line.

Line

Ribbon: 
Menu: 
Commandoregel:
Sneltoets:

Home > Draw
Draw > Line
Line
L

2 Druk op functietoets F1.

Een nieuw scherm wordt geopend en toont u direct de juiste helppagina voor 
het lijncommando. Hier kunt u lezen hoe u het commando start en wat de te 
volgen stappen zijn om het commando te voltooien. Zie figuur 1.17.

3 Sluit het helpvenster.
4 Annuleer het lijncommando door op Esc te drukken.
5 Sluit de tekening.
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Figuur 1.17

1.6 Samenvatting

De eerste kennismaking met AutoCAD zit erop. Er zullen nog veel nieuwe com-
mando’s en bijbehorende oefeningen volgen. In ieder geval weet u nu waar u 
het een en ander kunt vinden. De belangrijkste punten van dit hoofdstuk:

•	 Het	herkennen	van	de	verschillende	onderdelen	van	de	AutoCAD-scherm-
indeling.

•	 Commando’s	geven.
•	 Commando’s	afbreken	met	Esc.
•	 Handelingen	ongedaan	maken	met	Undo.
•	 AutoCAD-commando’s	 zijn	 op	 verschillende	manieren	 te	 herhalen:	met	

een druk op de Enter-toets, de spatiebalk of via een snelmenu dat u via een 
klik met de rechtermuisknop oproept.

•	 Op	de	commandoregel	of	 in	de	Dynamic Input-velden verschijnen op-
drachten of vragen om de commando’s te kunnen voltooien.

•	 Druk	op	functietoets	F1 om direct de helppagina’s van het commando waar 
u mee bezig bent op te roepen.



249

 Register

Symbolen

[...]  67
@  72
#  72

A

afdrukken
afdruk centreren  209
afdrukschaal  203
arceringen  204
lijntype  204
line type scale  204
maatinstellingen  204
model  205
opties  210
oriëntatie  208
papierformaat  206
papiermarges  204
PDF  206
plot style table  211
preview  208, 209
printer selecteren  206
schaal instellen  207
selectie  207
teksthoogte  204

afdrukvoorbeeld  224
afronding  124

multiple  125
opties  125
polyline  125
radius  125
trim  125
undo  125

afschuining  126
angle  126
distance  126
method  127

multiple  127
opties  126
polyline  126
trim  126
undo  126

arcering  163
annotative  171
associative  171
boundary  163
gebied bepalen  164
hoek  167
island detection  172
kleur  166
patroon  164, 165
schaal  167
splitsen  171
transparantie  166
weergavevolgorde  172
wijzigen  169

Array  119
assenstelsel  63

UCS-icoon  64
X-as  64
Y-as  64
Z-as  64

AutoCAD
opties  245

AutoCAD menu   8

B

back-up  27
bestand

back-up  23
meerdere tegelijk openen  230
nieuw  23
openen  25
opslaan  27
sjabloon  24
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bestandstype  27
backwards compatible  28
BAK  23
DWG  23, 27
DWT  24
DXF  27
verschillende AutoCAD-versies  29

blokken  234
annotatief  236
definitie  235
en lagen  241
invoegen  238
maken  234
referentiepunt  235
roteren  240
verschalen  240

boog  93
3 points  94
center, start, angle  94
center, start, end  94
center, start, length  94
continue  94
start, center, angle  94
start, center, end  94
start, center, length  94
start, end, angle  94
start, end, direction  94
start, end, radius  94

C

Center-markering  194
Chamfer  126
cirkel  89

2 points (2P)  90
center diameter  90
center radius  90
opties  90
tan, tan, tan  90

color  145
commando

activeren  16
afbreken  17
beëindigen  17
geven  16
herhalen  18

commandoregel  14
coördinaat

absolute nulpunt  63
absoluut  63
nulpunt  63
polair  68
relatief  66

coördinaten
UCS-icon  19

Copy  98

D

direct distance entry  72
drafting settings  54

object snap  54
polar tracking  75

DWF  216
dynamic input  15, 70

dimension input  71
dynamic prompt  15, 70, 71
maten invoeren  15
opties kiezen  15
pointer input  70, 71

E

eenheden  61
angle  62
inch  61
insertion scale  63
length  62
lightning  63
millimeters  61
precision  62
sample output  63

eigenschappen
ByLayer  153
kopiëren  158

eigenschappen palette  156
gegevens controleren  156
gegevens uitlezen  156
objecteigenschappen aanpassen  156

ellips  91
arc  92
center  92
opties  92

Enter  17
evenwijdige kopie  127

erase  128
exit  128
layer  128
opties  128
through  128
undo  128

explode  116
exploderen  116
Extend  105



251Register

F

Fillet  124

G

gebruikersinterface  7
gegevens uitwisselen

AutoCAD  230
copy  229
copy with basepoint  230
knippen  229
kopiëren  229
paste  229
paste as block  230
paste to original coordinates  230
plakken  229

GRID  79
grip  48

H

Hatch  163
help  21
hulplijn  131

I

inzoomen  32

J

join  116

K

kleuren  146
knippen  105

crossing  105
edge  105
erase  105
fence  105
opties  105
shift  106
undo  105

komma  72
kopiëren  98

array  98
multiple mode  98
opties  98
single mode  98

kruisdraad  19

L

lagen  135
aan  140, 147
aanzetten  141
activeren  147
afdrukken  148
bevroren  140, 147
ByLayer   154
color  145
defpoints  140
eigenschappen aanpassen  145
evalueren  148
hulpmiddelen  157
kleur  140, 147
kleur instellen  148
lijndikte instellen  152
lijntype instellen  151
linetype  145
lineweight  145
maken  147, 150
ontdooid  140
open  140
op slot  140, 147
paneel  139
regenereren  141
symbolen  140
uit  140
verwijderen  147

lagen palette  145
layout  213

aanmaken  215
afdrukken  215, 225
indelen met viewports  216
kader  220
kopiëren  227
Page Setup Manager  216
paper mode  216
verschillende aanmaken  226
verwijderen  227
viewport  216
viewport aanmaken  220
viewport aanpassen  223
viewport beveiligen  223
viewport instellen  220
viewport openen  223
viewportschaal  222
viewportschaal instellen  220
viewport verbergen  224
viewport zoomen  223

lijn  65, 83
close  67, 83
opties  67, 83
undo  67, 83
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lijndikte  159
lijnsoort  159
lijntypebibliotheek  151
lijntype schaal  160
linetype  145
lineweight  145

M

maatlijnen  187
associatief  194
automatisch aanpassen  194, 195
basismaat  192
beginpunt  190
diameter  193
extentielijn  190
hoekmeting  193
kettingmaat  192
lineair  190
plaatsen  189
posities bewerken  194
positioneren  195
radius  193
stijl  196
tekst positie  195
uitgelijnd  193

maatlijnstijl  196
activeren  198
Alternate Units  197
annotatief  197
booglengte  197
center markeringen  197
eenheden  197
Fit  197
inches  197
lijnen instellen  197
lines  197
millimeters  197
pijlpunten  197
Primary Units  197
symbolen en pijlpunten  197
tekstplaatsing  197
tekststijl  197
Text  197
Tolerances  197
toleranties  197
verschaling  197

maten controleren  80
met distance  81
met dynamic input  81

meten  80
distance  81

Mirror  104
move

basepoint  96
Move  95
muis

knoppen  19
linkermuisknop  19
rechtermuisknop  19
snelmenu  19
wiel  19

muiswiel  31
pan  31
zoom  31
zoom extents  33

multileader
block  200
tekst  200

multileaderstijl
content  200
Leader Format  200
structure  200

N

Navigation Bar  36

O

object
eigenschappen  154
eigenschappen aanpassen  154
eigenschappen palette  156
van laag wisselen  144

object snap  51
Apparent Intersection  59
Center  59
eenmalig  58
Endpoint  59
Extension  59
From  59
Insert  60
Intersection  59
Midpoint  59
Nearest  60
Node  60
None  60
Osnap Settings  60
Parrallel  59
Perpendicular  59
Quadrant  59
snap overrides  58, 60
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snelmenu  60
Tangent  59
werkbalk  59

object snap tracking  76
Offset  127
oops  21
opslaan  27
ortho  73

90 graden  73

P

page setup
aanmaken  215

pan  31, 32
pan realtime  37
patroonkopie  119

pad  123
rechthoekig  122
rond  120

PDF  206
pickbox  42
pijlen  199
POLAR  74

increment angle  75
tekenhoeken  74

Polygon  117
polylijn  113

arc  114
close  114
exploderen  116
gesloten polylijn  114
maken  116
opties  114
tekenen  115
undo  114

polyline  85
Polyline  113
pos-nummers  199

Q

quick access werkbalk  9

R

rechthoek  87
area  87
chamfer  87
dimensions  87
elevation  87

fillet  87
opties  87
rotation  87
thickness  87
width  87

rekken  131
ribbon

automatisch aanpassen  14
dashboard  12
fly-out  12
knoppen  12
panelen  10
punaise  13
tabbladen  10
zwevend  11

rollover tooltip  145
Rotate  99
roteren  99

copy  100
opties  100
reference  100

S

Scale  101
search menu  10
selecteren

all  48
crossing window  45
cycle  48
grips  48
last  47
objecten  41
object uit selectie verwijderen  43
previous  47
remove  44
selection cycling   46
selection preview  42
select objects  44
speciale selectiemethoden  47
visuele hulpmiddelen  42
window  44

selectiemethoden  41
shift  49
sjabloon  243
slotje  143
SNAP  79
spiegelen  104
statusbalk  15
Stretch  131
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tabel  181
aantal kolommen instellen  184
aantal rijen instellen  184
celstijl  183, 184
invoegen  184
kolombreedte instellen  184
maken  181
rijhoogte instellen  184
stijl  182

tekening
afdrukken  205

tekenveld  14
tekst  173

alinea  177
korte tekst  176
multi line  177
ribbon  178
single line  176
wijzigen  180

teksthoogte  175
tekststijl  173

dialoogvenster  174
effecten  175
instellen  174
lettergrootte  173
lettertype  173

tekstverwerker  177
template

opslaan als template  244
titelbalk  8
tooltip  12
tooltip extended  12
Trim  105

U

UCS-icoon layout  216
uitzoomen  32

V

veelhoek  117
circumscribed  118
edge  118
inscribed in circle  118
opties  118

verlengen  105
crossing  105
edge  106
fence  105
opties  105
shift  106
undo  106

verplaatsen  95
verschalen  101

copy  101
opties  101
reference  101
schaalfactor bepalen  101

verwijderen  42, 48
ViewCube  35

W

werkbalken  10
workspace  9

3D basics  9
3D modelling  9
AutoCAD Classic  10
Drafting & Annotation  9

Z

zoom  31
regenereren  33
zoom all  38, 39
zoom extents  38, 39
zoom in  39
zoom object  38
zoom out  39
zoom previous  38
zoom realtime  38
zoom window  38



BASISCURSUS
AUTOCAD 2014 EN LT2014

HAROLD WEISTRA

HAROLD W
EISTRA

AUTOCAD
2014 EN LT2014

Technische tekeningen maken moeilijk? Niet met dit boek uit de bekende serie Basiscursus! 
Stapsgewijs en op heldere wijze leert u snel volledige tekeningen maken in AutoCAD en AutoCAD LT.
 
Aan de hand van voorbeelden, illustraties en oefeningen leert u basisvormen op maat in de tekening 
plaatsen of construeren. Met behulp van de vele bewerkingscommando’s combineert u deze 
objecten tot complete tekeningen.
 
Door middel van lagen, kleuren, lijntypes en lijndiktes brengt u structuur in uw tekeningen. Ook het 
plaatsen van arceringen, teksten, tabellen en maatlijnen ontbreekt natuurlijk niet! Afsluitend leert u 
verschillende manieren om de tekening af te drukken of om te zetten naar PDF.
 
Het boek is gebaseerd op AutoCAD versie 2014, maar is ook geschikt voor oudere versies. Iedereen 
die technische tekeningen kan lezen en deze nu zelf wil leren maken, kan direct met het boek aan 
de slag. Alle basisvaardigheden worden stapsgewijs op een begrijpelijke manier uitgelegd. Door de 
vele oefeningen leert u snel wat u in de praktijk nodig hebt!

OVER DE AUTEUR 
Harold Weistra werkt al meer dan 25 jaar met AutoCAD. Hij is een Autodesk Certifi ed Instructor en 
eigenaar van een Autodesk Authorized Training Center.

BASISCURSUS

980

978 90 12 58584 2

7190 SDU Cover_AutoCAD2014-LT2014.indd   1 08-08-13   14:26




